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10.1 General Concepts 

The Data Acquisition toolset provides user-friendly functions that compile disparate data 

sources employed in the civil design process. The primary goal of the Data Acquisitions toolset 

is the creation of an existing surface DTM. The tools are available for users of the following civil 

products: MX, InRoads, GEOPAK, PowerSurvey, and PowerCivil for North America. 

All Data Acquisition data is stored in the active DGN Model and can be exported to various file 

formats as required. 

Recommendations for Usage:  

1. It is strongly recommended that all Data Acquisition usage occur in a 3D DGN Model. 

Some tools require the 3D Model to operate as expected. 

2. Also, it is strongly recommended that all MicroStation DGN levels specified in your 

Style Library are already created prior to importing data via the Data Acquisition tools. 

10.1.1 Interface 

Data Acquisition tools are invoked from the Tasks navigation pane or from the Tools menu. 
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The interface opens to a Data Tree and a Details Panel. 

Note:  The panels can be docked, docked and pinned, or remain floating per your preference. 

Data Tree 

The Data Tree organizes information into logical groupings for ease of selection and superior 

visibility. 

·        Right-click on tree elements (branches) to access related commands. 

Details Panel 

The Details Panel presents information associated with whichever item is currently selected in 

the Data Tree. 

Drag and Drop Functionality 

Files (of the formats listed above) can be imported by dragging from Windows Explorer and 

dropping into the Data Tree. 

10.2 Create a New Field Book 

To create a new field book, right-click on the Field Books branch of the Data Tree then click 

New on the menu. 

Note:  To change the name of a field book, select the field book in the Data Tree then open the 

Element List tab of the Details Panel. Select the field book name in the Name cell of the Details 

Panel, delete the existing text, enter the new name, and strike the Enter key. The new name will 

appear in both the Data Tree and the Name cell of the Details Panel Element List. 

10.2.1 Add Survey REC file 

If you wish to add survey REC file, simply right-click on the Field Book branch in the Data 

Tree. 

a. Select Load on the menu and choose File from the submenu. 

b. Navigate to the desired file then double-click it. 

Note:  If you load a file with an ambiguous file extension, you will be prompted to identify that 

file's format. Choose from the available options on the Data Format dialog and click Accept. 

In the process of loading raw data, the system performs the following actions: 

mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Tree_Panel.htm
mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Details_Panel.htm
mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Tree_Panel.htm
mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Tree_Panel.htm
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      Point and Linear Features, Setup, and Observation data are stored in the DGN. Please 

Note: Setups, Observations, and Control Points will be drawn to specific levels in the 

DGN file. 

      Linking Codes are processed to create line work (Linear Features). 

      Points and Linear Features are symbolized according to the Feature Style table. 

Data Acquisition uses three (3) types of Linear Feature:  Dynamic Link, Point List, and Graphic. 

These linear feature types are hierarchical. A Dynamic Link type can be converted to a Point List 

or a Graphic type. A Point List type can be converted to a Graphic type. 

Linear Features, automatically generated through the use of one of the Linking Methods (Field 

Code, Consecutive, or Non-Consecutive), are created as “Dynamic Link” linear features and 

have a property type of GeneratedByLinking. These linear features are constructed based on the 

combination of linking and/or field codes and the order in which field points are collected. If a 

linear feature is started, it will link all subsequent points with same field code until it encounters 

another start or an end depending on the Linking Method used. 

Dynamic Link:  Creation is described above. All points within these linear features are of 

the same field code and the linking of these points is in the order they were collected in the 

field. Starting, stopping, and changing of geometry of these linear features is controlled by 

a combination of linking and/or field codes. Editing consists of modifying linking and/or 

field codes or moving the location of the survey point features. 

Point List:  These linear features are generated by a list of points that can be of any field 

code. These have a property type of GeneratedByPointList. The order of the points in the 

linear feature is not dependent on the order they were collected in the field, but is solely 

dependent on the order they appear in the list. The Geometry of this type is still controlled 

by the link codes but not where the linear feature starts and ends. This is controlled by the 

point list. Editing consists of modifying linking and/or field codes or moving the location 

of the survey point features in addition to modifying or managing the order of the points in 

the list. 

Graphic:  A graphic linear feature can be any MicroStation graphical element and is not 

tied to any survey point features. These have a property type of Graphic. Editing consists 

of using any MicroStation edit tool. The symbolization of these linear features can be 

controlled by the assigned feature, but assigning a specific feature is an option – not a 

requirement. 



 Chapter 10 - Data Acquisition  GEOPAK Survey 

4 Missouri Department of Transportation 9/16/13 

 

Points and Linear Features created from a REC file 

 

Surface triangles created from the REC files – The surface is generated automatically 

based on the surface settings of the imported point features and linear features. 
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10.3 Creating Surfaces 

·      Right-click the Surfaces branch then choose Create Surface from the available menu 

options. 

 

 
 

10.3.1 Create an Empty Surface 

To create an empty surface, right-click on the Surfaces branch of the Data Tree, select Create 

Surface from the menu, and choose Empty Surface from the submenu. This creates an empty 

surface with a default name. 

 

Note:  To change the name of an empty surface, select the surface in the Data Tree then open the 

Element List tab of the Details Panel. Click in the Name cell of the surface, delete the existing 

text, enter the new name, and strike the Enter key. The new name will appear in both the Data 

Tree and the Name cell of the Element List. 
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10.3.2 Create New Surface from Field Book 

To create a surface from field book data (survey data): 

1. Right-click on the Surfaces branch. 

2. Select Create Surface on the menu. 

3. Choose From Field Book on the submenu. 

4. Select the desired field book. 

Note:  The available field books are those listed under the Field Books branch in the Data Tree. 

A surface named “All Field Books” is automatically created from the survey data. This function 

is useful to recreate the “All Field Books” surface due to accidental deletion or to create a 

surface for additional field books. 

Example:  Were you to create separate field books for special uses, perhaps a special field book 

for a particular bridge deck, you would then be able to create a surface for the bridge deck while 

preserving the integrity of the main surface. 

10.3.3 Create New Surface Based on Field Book Selection Set 

The Create New Surface from Field Book Selection Set function builds a separate surface from a 

selection set of Field Book data. 

Note:  This option is not a method to extract 3D graphic data to a surface. See Extracting 

Graphics section for this method. 

To create new surface from field book selection: 

mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Extract_Graphics.htm
mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Extract_Graphics.htm
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1. Create a Selection Set of the desired point and linear feature elements in the DGN Model. 

2. In the Data Tree, right-click on the Surfaces branch. 

3. Select Create New Surface from the menu. 

4. Choose the From Field Book Selection Set item from the submenu. 

To rename the created surface, select it in the Data Tree then open the Element List tab of the 

Details panel. Click in the Name cell of the surface, delete the existing text, enter the new name, 

and strike the Enter key. The new name will appear in both the Data Tree and the Name cell of 

the Details Panel Element List. 

10.3.4 Create a New Surface by Import External File 

To create a new surface by importing data from an external file: 

1. Right-click on Surface branch in the Data Tree. 

2. Select Create New Surface from the menu 

3. Choose the Import External Surface item from the submenu. 

4. Choose the type of file that you wish to import from the list of available options. 

5. Navigate to the file you wish to import and double-click on it. 

The name of the surface is set to match the selected file name. To rename the created surface, 

select it in the Data Tree then open the Element List tab of the Details Panel. Click in the Name 

cell of the surface, delete the existing text, enter the new name, and strike the Enter key. The new 

name will appear in both the Data Tree and the Name cell of the Element List. 

10.3.5 Create a New Surface by Import from Point Cloud 

The MicroStation Point Cloud data can be used to create a Data Acquisition surface. This option 

is available with the V8i SELECTseries 2 products. 

Note:  Extraction of Point Cloud data is always from the View 1 window. 

The loaded Point Cloud data must then be visualized to display only the data to be used in the 

surface. 

For example, a typical scenario would be:  In the View Window 1, view the Point Cloud data by 

“classification” then enable ONLY the “ground” classified points. Optionally, place a Fence 

around the portion of the Point Cloud data from which you wish to build a surface. 

Extraction of the Point Cloud data supports two (2) selection methods. 

·        Method 1) By entire View 1 window. 

·        Method 2) By Fence (inside) (from View 1 window) 

If a Fence is enabled, it will be used. If a Fence is not enabled, the entire View 1 window area 

will be used as the extraction area. 
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To create a new surface by importing data from MicroStation Point Cloud elements: 

1. Set the View 1 window to display desired points for surface creation. 

2. Right-click on Surface branch in the Data Tree. 

3. Select Create New Surface from the menu. 

4. Choose the Import from Point Cloud External Surface item from the submenu. 

5. Choose the type of file that you wish to import from the list of available options. 

6. Navigate to the file you wish to import and double-click on it. 

The name of the surface will be “Point Cloud Surface_1”. To rename the created surface, select 

it in the Data Tree then open the Element List tab of the Details Panel. Click in the Name cell of 

the surface, delete the existing text, enter the new name, and strike the Enter key. The new name 

will appear in both the Data Tree and the Name cell of the Element List. 

See LIDAR and Raster topics for more information on additional inputs required for those 

formats. 

10.3.6 Surface Operations 

When you right-click on a surface's branch in the Data Tree, a variety of operations may be 

performed on that surface. 

10.3.6.1 CREATE GRAPHICS 

The surface features (triangles, contours, etc.) currently displayed are permanently written to the 

DGN. 

Note:  The Surface Feature display toggles visualize the features as transient graphics. 

Closing Data Acquisition will cancel the visualization of these features. 

10.3.6.2 VERTICAL EXAGGERATION 

 

Vertical Exaggeration allows the User to distort the surface features. This option allows the user 

to visually find any vertical abnormalities in the surface more clearly. 
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·      Factor – available scaling factors. Select a factor and click More or Less to exaggerate 

the selected surface features. Note: The grey value at the top of the list indicates the 

current scale value applied to the selected surface 

·      More – increases the vertical exaggeration of the currently displayed surface features by 

the selected factor value. 

·      Less – reduces the vertical exaggeration of the currently displayed surface features by the 

selected factor value. 

·      Reset – returns the surface feature display to a true vertical representation. 

Note:  The exaggeration is reset to true values when Data Acquisition is closed. 

10.3.6.3 CLIP BY POLYGON 

The Clip by Polygon function trims a portion of the surface. Options are Internal and External: 

·        Clip Internal removes everything within the shape. 

·        Clip External removes elements outside of the shape. 

The Draw a Shape function outlines the area to be clipped. 

10.3.6.4 APPEND/MERGE EXTERNAL SURFACE 

Appends or merges an external surface into the currently selected surface without the need to 

first import this external file into a separate surface. 

See the Append/Merge help for additional information on how appending and merging works. 

The external surface can be any of the supported surface types. See Creating Surfaces help page 

for a list. The external surface is read directly into the existing surface as either appended or 

merged as specified. 

10.3.6.5 EXPORT TO 

Allows export of the selected surface data to one of four formats, allowing design processes to 

continue in native design applications. 

·      GEOPAK TIN – creates a TIN file, which is the standard GEOPAK terrain model format 

·      InRoads DTM – creates a DTM file, which is the standard InRoads terrain model format 

·      MX FIL – creates a surface in a MX model file 

mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Merging_or_Appending_Surfaces.htm
mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Creating_Surfaces.htm
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·      LandXML – creates a surface in a LandXML file (Version 1.2 of the LandXML 

specification is used.) 

10.3.6.6 DELETE 

Click Delete to remove the surface from the project. 

10.3.7 Importing LIDAR files 

10.3.7.1 CREATING SURFACES FROM LIDAR 

Surfaces can be created from both LIDAR XYZ and LAS files through separate, though similar, 

processes. 

 LIDAR XYZ – LIDAR data that has been processed from the raw binary files into a 

points file containing only a single surface, usually the existing ground surface 

 LIDAR LAS – the binary file that usually contains point data with multiple 

classifications 

10.3.7.2 CREATE A NEW SURFACE FROM LIDAR XYZ 

1. In the Data Tree, right-click on the Surfaces branch then select Create Surface from the 

menu 

2. Choose Import External Surface from the menu and Import Lidar XYZ from the 

submenu. 

3. Navigate to the desired file then double-click it. 

4. Set the desired filtering options and appropriate filtering tolerances then click Accept. 

 

Filter Options: 
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·      Tile Filter – The tiling algorithm is a recursive divide and conquer algorithm that 

divides the LIDAR data set into tiles. A best fit plane is calculated for each tile, and 

LIDAR points are removed if they fall within the user set Z tolerance to the plane. 

·      TIN Filter (Recommended) – The TIN algorithm filters LIDAR points if they fall 

within the user set Z tolerance of the triangle planes. The TIN algorithm first tiles the 

LIDAR points into tiles with a maximum of 2 million points and then repetitively 

triangulates each tile filtering out points.  Tin Filter option is much slower than the Tile 

option, but gives 90% + reduction rates while maintaining TIN accuracy within desired 

values.  With “Reinsert Points” checked on (again recommended) the following process 

happens:  After all the points are filtered out, a „final‟ TIN is built from the remaining 

points. At this point in the process, all of the discarded points are draped on this „final‟ 

TIN … any discarded points that fall outside of the vertical tolerance are added back in 

and the TIN is rebuilt. This is a safety measure, allowing the re-inserting of points that 

may have been mistakenly removed.  When using the Tin Filter also always use the 

“Coarse” option.  The “Coarse” option is much more efficient at thinning down the 

data.. 

·        No Filter – No filtering is applied 

Filter button – generates a report showing the amount of reduction in the number of point 

features before data is imported as a surface 

10.3.7.3 CREATE A NEW SURFACE FROM LIDAR LAS FILE 

1. In the Data Tree, right-click on the Surfaces branch then select Create Surface on the 

menu. 

2. Choose Import External Surface from the menu and Import Lidar LAS from the 

submenu. 

3. Navigate to the desired file then double-click it. 

4. As there may be multiple classifications in the file, choose the classifications you wish to 

import in the Selected Features section of the Lidar LAS dialog. 

5. Set the desired filtering options and appropriate filtering tolerances then click Accept. 

·      Click the Filter button to generate a report showing the amount of reduction in the 

number of point features before data is imported as a surface. 

6. Click the Accept bar to import the selected surface according to the specified parameters. 

 

 

 

 



 Chapter 10 - Data Acquisition  GEOPAK Survey 

12 Missouri Department of Transportation 9/16/13 

 

10.3.8 Creating Raster Surfaces 

Data Acquisition can import surfaces from the following raster file types. 

·        DTED 

·        ERDAS IMG 

·        Spot Dimap 

·        USGS DEM 

·        USGS STDS 

·        GeoTiff 

Note:  As the source files may have been compiled in a different coordinate system than the one 

used in your project, the import process must transform the data. It may be useful to set the 

coordinate system for your DGN file prior to beginning the import process. 

1. In the MicroStation window, open the Tools menu, choose Geographic, and Select 

Geographic Coordinate System from the submenu. 

2. On the Geographic Coordinate System dialog, use the tools available to identify and 

apply the desired system. 

Note:  For more information, see the Geographic Coordinate System Dialog topic in the 

MicroStation Help. 

10.3.8.1 CREATE A SURFACE FROM RASTER FILE 

1. In the Data Tree, right-click on the Surfaces branch then click Create Surface on the pop-

up. 

2. Choose Import External Surface from the menu and Import Raster from the submenu. 

3. Navigate to the desired file then double-click it. 

4. On the Surface from Raster dialog, review the default import settings and make 

adjustments as necessary. 

·      The Image Projection area displays the coordinate system of the raster file; this 

information cannot be edited. 
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5. The Target Projection area displays the coordinate system of the DGN. Click the Select 

Target Projection System to choose a coordinate system other than that currently assigned 

to the DGN. 

·      When the raster is imported, the data is transformed from the source file's 

coordinate system to the system designated as the Target Projection. 

5. To reduce the number of data points imported to the Data Acquisition surface, check the 

Filter box and enter the Maximum Point Number value in the field provided. 

6. Click Accept to import the selected raster surface data according to the specified 

parameters. 

10.3.9 Merging or Appending Surfaces 

Both the Merge and Append functions combine two surfaces into a single surface; the difference 

is that Merge is a destructive operation while Append is not. 

Example:  You might combine an aerial survey with field survey data or a LIDAR surface with 

field survey data. 

Example:  Merge Surface 1 into Surface 2 

When Surface 1 is merged, all the data in Surface 2 underneath the boundary of surface 1 is 

destroyed and then Surface 1 is used to fill the destructed area. 

Example:  Append Surface 1 into Surface 2. 

 

When Surface 1 is appended, Surface 2 remains 100% intact. The data contained in surface 1 is 

intermingled with the information contained in Surface 2. 
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10.3.9.1 TWO METHODS TO CREATE A MERGED/APPENDED SURFACE: 

1. Merge/Append surfaces already contained in the DGN file 

2. Merge/Append external surfaces 

10.3.9.2 MERGE/APPEND INTERNAL SURFACES 

1. Create a new, empty surface to contain the merged/appended data: 

2. Right-click on the Surfaces branch of the Data Tree and select Create Surface from the 

menu then choose Empty Surface from the submenu. This creates an empty surface with 

a default name. 

3. Right-click on the new surface and choose Append From. 

4. Select the base surface. This is usually the largest surface or the one that acts as lowest 

level of information to be superseded or augmented by more detailed information. 

 

5. Right-click again to merge or append additional surfaces. 

10.3.9.3 MERGE/APPEND EXTERNAL SURFACES 

The process is identical to the internal surface process except that, instead of using surfaces 

already stored in the DGN, you must select external files with formats supported by Data 

Acquisition. The external surface can be any of the supported surface type. The external surface 

is either appended to or merged with the existing surface. 

10.3.9.4 ONE INTERNAL SURFACE\ONE EXTERNAL SURFACE 

1. Right-click on the surface to which you wish to add surface data. 

2. Choose Append External Surface or Merge External Surface from the menu. 

3. Navigate to the desired file and double-click it. 

10.3.9.5 IMPORT TWO EXTERNAL SURFACES, APPEND, THEN MERGE 

1. Import the surfaces you wish to merge (see Importing Surfaces). 

2. Create an empty surface (see Creating an Empty Surface). 

3. Right-click on the newly created empty surface then choose Append From and select the 

first of the imported surfaces. 

mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Merging_or_Appending_Surfaces.htm#Merge_Append_Internal_Surfaces
mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Demo_Topic.htm#Field_Data_Formats:
mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Demo_Topic.htm#Field_Data_Formats:
mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Creating_Surfaces.htm#Create_a_New_Surface_by_Import_External_File
mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Creating_Surfaces.htm#Create_an_Empty_Surface
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4. Right-click on the newly created empty surface then choose Merge From and select the 

second of the imported surfaces. 

5. Right-click again on the previously empty surface then choose Merge From and select the 

second of the imported surfaces. 

10.3.9.6 MERGE TWO EXTERNAL SURFACES 

1. Import the first surface you wish to merge (see Importing Surfaces). 

2. Right-click on the newly imported surface and choose Merge External Surface from the 

menu. 

3. Navigate to the desired surface file then double-click it. 

10.3.9.7 CHANGING MERGE/APPEND ORDER 

Surfaces are processed from the top of the surface list to the bottom. Each surface in the surface 

list is merged/appended to the result of the merge/append operations performed on the items 

above, thus there may be occasions where the order of surface merging needs to be adjusted. To 

do so: 

1. Right-click on the surface name in the Data Tree and choose Rearrange Surfaces from the 

menu. 

2. On the Composite Surface dialog: 

 

a. Select a surface and click the Up arrow to raise the selected surface's position in 

the surface list. 

b. Select a surface and click the Down arrow to lower that surface's position in the 

surface list. 

c. Select a surface and click Delete to eliminate the surface. 

d. Expand the drop-down and choose whether you wish the surfaces to be Appended 

or Merged. 

 

 

 

 

mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Creating_Surfaces.htm#Create_a_New_Surface_by_Import_External_File
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10.3.10 Extract Graphics 

10.3.10.1 CREATE SURFACES BY EXTRACT GRAPHICS 

3D graphic data may be supplied as a result of various processes. This image is an example of 

typical data resulting from a photogrammetric process. 

 

To create a surface from 3D graphic elements: 

1. Create an empty surface by right-clicking the Surface branch in the Data Tree then 

choosing Create Surface from the menu and Empty Surface from the submenu. 

2. Expand the newly created surface's branch in the Data Tree. 

3. Use MicroStation's Element Selection functionality to select every instance of a 

particular graphic feature (spot or breakline or void etc.). 

4. In the Data Tree, expand the Features branch and right-click on the Surface Feature 

corresponding to the selected DGN 3D graphical data. For example, if you selected 

breaklines in the workspace, you would then right-click on Breaklines in the Data Tree. 

In the image above, the selected items were breaklines, so the right-click and import were 

performed on the Breaklines branch. 

5. On the pop-up, click Import Selection. 

6. Repeat the select and import process for all other Surface feature types you wish to 

import from the graphical data:  Spots, Triangles, Holes, Boundaries, etc. Each type of 

feature must be imported separately.  
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Note:  If you wish to employ graphic information stored in a DGN file other than the DGN file 

that contains your Data Acquisition project, then you must attach the source file of your graphics 

as a reference (File > Reference > Attach References). There is no provision in this version to 

extract 2D graphics with text indicators of the elevation. 

·      Features – provides access to symbology settings for each kind of surface feature – Each 

branch is accompanied by a checkbox that controls the visibility of the branch and sub-

branches; set the symbology for each type in the Details Panel. 

·      Spots – random surface points 

·      Break lines – break line elements 

·      Triangles 

·      Holes – a void in the surface whereby underlying surfaces can control the triangulation 

·      Major Contours 

·      Minor Contours 

·      Boundaries – the external boundary of the surface 

·      Island – a triangulated area inside of a hole 

·      Void – an area defined by a closed shape that demarcates a region of missing data or 

obscure areas – No point or break data located within the void area is utilized and no triangles 

are created inside the void areas. The Void coordinates are included in the triangulation and void 

lines between successive void coordinates are inserted as drape lines on the surface. Therefore, 

they do not change the slope or elevations of the surface. 

·      Break Void – A Break Void utilizes the vertex elevations of the graphical element, while the 

void lines between successive void coordinates are inserted as break lines; therefore, break voids 

change the slope and elevations of the TIN surface. 

·      Drape Void – Drape Void elements are treated as strictly 2-dimensional and are inserted 

post-triangulation. The area within the Drape Void is an aperture through the surface over which 

the void is draped. The graphical element elevations (if they exist) are not included in the 

triangulation. The void vertices and lines are draped onto the surface. The addition of a Drape 

Void should not change the surface grading external to that void. 

·      Drape Boundary – an exterior surface boundary that determines its elevations by draping on 

the underlying surface 

 

 

10.3.11 Exporting a Surface 

When you have finished surface creation and editing, you may wish to export the Surface to one 

of Bentley‟s native surface formats OR to LandXML. 

The Surfaces can be exported to: 

·        MX (FIL) 

·        InRoads (DTM) 

·        GEOPAK (TIN) 

·        LandXML version 1.2 

mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Details_Panel.htm
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10.3.11.1 EXPORT A DATA ACQUISITION SURFACE 

In the Data Tree, right-click on the desired surface, choose Export To from the menu and select 

the desired output format from the submenu. 

10.4 Exporting to COGO 

When you have finished processing data, you may wish to export the point and linear features to 

a coordinate geometry database and continue the design process with the native product's design 

tools. 

The points and lines can be exported to: 

·        MX model file (FIL) 

·        InRoads cogo file (ALG) 

·        GEOPAK cogo file (GPK) 

·        LandXML version 1.2 

10.4.1 Export to COGO 

In the Data Tree, right-click on the desired field book, choose Export To from the menu and 

select the desired output format from the submenu. 

10.5  Exporting a Surface 

When you have finished surface creation and editing, you may wish to export the Surface to one 

of Bentley‟s native surface formats OR to LandXML. 

The Surfaces can be exported to: 

·        MX (FIL) 

·        InRoads (DTM) 

·        GEOPAK (TIN) 

·        LandXML version 1.2 

10.5.1 Export a Data Acquisition Surface 

In the Data Tree, right-click on the desired surface, choose Export To from the menu and select 

the desired output format from the submenu. 
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10.6 Data Tree 

 

Top Row Buttons 

·      Select – Used to graphically select Data Acquisition point and linear features; selected 

feature properties are provided in the Details Panel. 

·      Details – Opens the Details Panel. 

10.6.1 Default Branch 

Default – At the top of the tree is the name of the active DGN model. All data imported is stored 

in this model. 

10.6.2 Survey Data Branches in the Data Tree 

When populated with data, the Data Tree contains one or more branches. Each branch is 

accompanied by a checkbox that enables/disables the visualization of the branch and sub-

branches. 

·      Field Books – expands to show all of the field survey data loaded into the project – 

To create a new field book, right-click on the Field Books branch. 

·      Field Book – Created as a subfolder under “Field Books” when survey data is 

imported to your project. 

·      Load – provides options to import Survey data from different sources 

·       File… – Allows the User to select a supported survey file for import 

mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Details_Panel.htm
mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Details_Panel.htm
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·       Trimble Link – Launches the Trimble Link software for importing of 

Trimble data formats 

·       Leica DBX – Launches Leica DBX import software for importing of 

that DBX data format 

·       Features from Current Graphics – Examines all graphical data in the 

current DGN model and compares the symbolgy against the currently 

loaded style file. Where the graphical data symbology matches a style 

file feature, the graphical data is converted to Data Acquisition Point 

and Linear features. 

·      Delete – allows the User to delete the currently selected Field Book 

·      Export – Allows the currently selected Field Book to be exported to GEOPAK, 

InRoads, MX and LandXML formats. 

·      Data Files – expands to show all of the raw survey data files currently loaded into 

the project – Each data file expands to show setups and observations. See the Survey 

Raw Data section of the Workflow help topic for more information. 

·      Control Points – lists the control points that exist in the project 

·      Point Features – lists points loaded from survey raw data files – The Point Features 

branch expands to show a list of individual feature names. 

·      Linear Features – lists linear features loaded from survey raw data files – The 

Linear Features branch expands to show a list of individual feature names. 

·      Observations – shows all observations contained in the project 

·      Adjustment – When activated, a Least Squares Adjustment. is applied to the Field 

Book. To activate the adjustment, right click on “Adjustment” and select Turn On. 

The circular symbol to the right of the Adjustment branch will become green when 

the adjustment option has been enabled. The check box toggles the graphical display 

of the error ellipses resulting from the adjustment. When active, the least squares 

adjustment properties are shown in the Detail Panel. Caution:  Once enabled, the 

adjusted data cannot be “unadjusted”. 

10.6.3 Point and Linear Features Expansion 

By expanding the Point Features or Linear Features branch, you can view data by individual 

feature style definition.  The Point Features branch displays different feature types that have been 

assigned to points in the Field Book. When you select one of these sub-branches, the Details 

Panel presents only points that have been assigned to the selected feature definition. 

The Linear Features branch can be similarly expanded and operates in much the same way. 

mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Workflow.htm#Add_Survey_Raw_Data
mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Workflow.htm#Add_Survey_Raw_Data
mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Least_Squares_Adjustment.htm
mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Details_Panel.htm
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10.6.4 Surfaces Branch 

Expand the Surfaces branch to see all of the surfaces stored in the active DGN Model. The 

surfaces may come from a variety of sources. 

The All Field Books branch, by default, is the surface built by triangulating all the data from all 

of the field books contained in the active DGN Model. It is created automatically anytime there 

is raw survey data contained in the Data Tree. 

Expand any surface in the tree to access more detailed information about the active DGN Model. 

·        Composing Elements 

·        Point Features – lists the DA Field Book points that contribute to the surface 

·        Linear Features – lists the DA Field Book linear features that contribute to the surface 

·        Composing Surfaces –  If this surface 

was created by merging/appending other surfaces, then this branch lists the surfaces that were 

used in the merge; if not, the branch lists no data. 

·        Features – provides access to symbology settings (by selecting the feature and editing the 

setting in the details panel) for each surface feature – Each branch is accompanied by a checkbox 

that controls the visibility of the branch and sub-branches; set the symbology for each type in the 

Details Panel. 

·        Spots – random surface points 

·        Break lines – break line elements 

·        Triangles 

·        Holes – a void in the surface whereby underlying surfaces can control the triangulation 

·        Major Contours 

·        Minor Contours 

·        Boundaries – the external boundary of the surface 

·        Island – a triangulated area inside of a hole 

·        Void – an area defined by a closed shape that demarcates a region of missing data or 

obscure areas – No point or break data located within the void area is utilized, and no triangles 

are created inside the void areas. The Void coordinates are included in the triangulation and void 

lines between successive void coordinates are inserted as drape lines on the surface. Therefore, 

they do not change the slope or elevations of the surface. 

·        Break Void – A Break Void utilizes the vertex elevations of the graphical element, while 

the void lines between successive void coordinates are inserted as break lines; therefore, break 

voids change the slope and elevations of the TIN surface. 

·        Drape Void – Drape Void elements are treated as strictly 2-dimensional and are inserted 

post-triangulation. The area within the Drape Void is an aperture through the surface over which 

the void is draped. The graphical element elevations (if they exist) are not included in the 

triangulation. The void vertices and lines are draped onto the surface. The addition of a Drape 

Void should not change the surface grading external to that void. 

·        Drape Boundary – an exterior surface boundary that determines its elevations by draping 

on the underlying surface 

mk:@MSITStore:C:/Program%20Files%20(x86)/Bentley/PowerGEOPAK%20V8i/Documentation/Data_Acquisition_Help.chm::/Details_Panel.htm
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10.6.5 Feature Styles Branch 

The Feature Styles branch, when expanded, is a read-only view of the currently accessed style 

file. 

The style file is set within the Design File Settings (or, optionally, via a configuration variable) 

and can be either a GEOPAK SMD file (which must be first saved as a XML file), an InRoads 

XIN file (the survey features from within the XIN are used), or a MX PSS file. 

Each feature corresponds to a survey field code. Drill down each feature style to see the currently 

used visualization settings for each code. 

Note:  Styles that display in RED text are styles that were used in the survey data but were not 

found in the specified SMD/XIN/PSS file. Add the missing features to the native style 

database and reattach the style file to your Data Acquisition seed file. 

10.6.6 Filters Branch 

The Filters branch allows you to create customized data filters for quick viewing of data sub-sets. 

These filters can be pre-created and stored with the Data Acquisition seed file for use with all 

projects generated from that seed. 

An example filter may highlight any points whose elevation is above or below the expected 

range within a Clients geographic area. 

 

Another example may be to highlight all “default” coded points to provide visual feedback of 

field coded points that did not match the available feature styles. 

 

10.6.6.1 FILTER CREATION 

To create a new filter, right-click on the word “Filter” in the data tree. Click New. 
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The Create New Filter dialog will activate. 

 

Name:  Supply a logical name for the filter. 

Category:  A custom category that will be used in the Data Tree as a branch for housekeeping 

purposes (, you have the option to group “like” filters together logically by using 

Category) 

Description:  Enter a brief description of the Filter. 

Use Fence:  True/False toggle 

Filter Value:  Click the browse button in the Filter Value field to launch the Filter dialog 

shown below. 

 

Filter Dialog: Multiple rows can be added to a single filter using combinations of Object Type, 

Property Name, Operator, and custom values to build up the required filter. Once the filter rows 

are completed, Accept the Filter and Accept the New Filter. The filter will appear in the Data 

Tree under “Filter <category> <name>”. 

Please note that between each row is an inferred “and”. For data to pass a filter, it must fulfill the 

attributes of filter line 1 AND the attributes of each subsequent filter line. 

10.6.6.2 FILTER ACTIVATION 

To activate one or more filters: 

1. Disable the display of the data type you are filtering (point features and/or linear features) 

within the Field Book area of the Data Tree. 
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2. Drill down the Filters branch to the specific filter/filters you wish to activate. 

3. Enable the desired filters. 

The data passing the enabled filters will display on your screen. 

To display the results of the filter in the Details panel, right-click on the filter and select Show 

Details. This will populate the Details panel with the data that has passed the filter. 

10.7 Linear Crossings 

Linear Crossings, when enabled, provides a Linear Feature crossings detection engine that 

continuously runs to provide feedback of crossing linear features. The feedback is provided in 

the Message Center of the Data Acquisition Details panel. 

Message Center Details 

 

Detected crossing features are displayed in the message center as shown above. Selecting any 

of the detected crossings in the list will center the current view to that crossing and place a 

circle around the intersection. 

Right-click on the selected crossing to access the options you see above. 

·      Save As: Saves the details to a text file 

·      Insert point into Linear Feature < A > using Elevation of Linear feature < B >:  Both 

of these “insert” options will create a new point and add that point into the first linear 

feature at an elevation that corresponds with the crossing linear feature. 

·      Insert point into both using average elevation:  This option averages the elevations at 

the crossing and inserts a new point that is added to both linear features. 
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All of the “insert” options require that the new point be inserted into a Point List type linear 

feature. If a Dynamic Link linear feature is selected, a pop-up message, similar to that shown 

below, will appear. 

 

·      Click “Yes”:  The Dynamic Link linear feature will be converted to a Point List linear 

feature, and the new point will be inserted. 

·      Click “No”:  The operation will be aborted. 

Please Note: The option to insert points into linear features is only one of many ways to 

resolve crossing linear features. Editing or breaking the linear feature, moving or re-coding 

points or even changing the linear feature DTM type are all valid methods to resolve this 

situation without the need to convert the linear feature type. Sound, practical  
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10.8 Individual Exercise:  

1) Open pw:\\District CADD\Survey\BENTON\J2P0223\data\Data_Acquisition.dgn 

 

 

2) Activate the Data Acquisition tool by selecting Tools > Data Acquisition 

 

 

3) Dock the Data Acquisition Details Pane to the bottom and Main Dialog to the right. 

 

 

4) In the Data Acquisition Main Dialog right-click on Field Books and create a new Field 

Book. 

 
 

 

5) Rename the Field Book in the Details Pane to J2P0223. 
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6) In the Data Acquisition Main Dialog right-click on the J2P0223 Field Book and select 

Load > File 
 

 
 

 

7) Select the 0059to13.REC file. 

 

The Folder should be set to the following location: 

 

pw:\\District CADD\Survey\BENTON\J2P0223\data\0059to13.rec 
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8) Review Survey Data visualized in DGN. 

 

 

9) Turn OFF the following three levels: 

 

Survey-Text-Description 

Survey-Text-Elevation 

Survey-Text-Feature 

 

 
 

 

 

10) Change the Drawing (Annotation) Scale to 1”=50‟ by selecting “Settings > Drawing 

Scale”. 
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11) In the Data Acquisition Pane, expand the Filters branch until you see Point Features 

0059to13 

 
 

Notice in the Data Acquisition Details Pane that Point Features 0059to13 is listed 

 

 
 

 

12) In the Data Acquisition Pane, under Filters Right Click on Point Features 0059to13 and 

select “Show Details”. 
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13) The Data Acquisition Details Pane will now list all the points that are included in the 

0059to13 REC (Survey) file. 

 

 
 

 

14) In the Data Acquisition Details Pane Right Click on the List Banner and select View > 

Turn On Auto Center. 
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15) In the Data Acquisition Details Pane locate Point 885 and highlight the row.  Once the 

row is highlighted the point should be centered in the screen 

 

 
 

 

 

 

  

 

 

 



 Chapter 10 - Data Acquisition  GEOPAK Survey 

32 Missouri Department of Transportation 9/16/13 

 

16) In the Data Acquisition Pane use the “Select” button to identify the Survey Chain that 

starts with point 885. 

 

 
 

 

17) In the Data Acquisition Details Pane the Survey Chain named 107_1 should now be 

listed. 

 

Since the Survey Chain 107_1 was created using linking codes it is considered a Dynamic 

Link Linear Feature.   
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18) What we are going to attempt to do is join Survey Chain 107_1 to the Survey Chain 

directly to the Southwest (Chain 107). 

 

Before the two chains can be joined together they both need to be drop from a Dynamic 

Link Linear Feature to a Point List Linear Feature. 

 

To drop the 107_1 chain, highlight the row in the Details Pane and Right Click and select 

“Convert to Point List Linear Feature”  

 

  
 

 

19) Once the 107_1 Survey Chain is converted to a Point List Linear Feature in the Details 

Pane the Creation Type should be listed as GeneratedByPointList.   
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20) In the Data Acquisition Pane use the “Select” button to identify the Survey Chain that is 

just southwest of the 107_1 chain and ends with a point 876. 

 

 
 

 

21) In the Data Acquisition Details Pane the Survey Chain named 107 should now be listed. 

 

Since the Survey Chain 107 was created using linking codes it is considered a Dynamic 

Link Linear Feature.   
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22) Again what we are attempting to do is joining Chain 107_1 to the Chain 107.  

 

Before the two chains can be joined together the 107 Chain needs to be drop from a 

Dynamic Link Linear Feature to a Point List Linear Feature. 

 

To drop the 107 chain, highlight the row in the Details Pane and Right Click and select 

“Convert to Point List Linear Feature”  

 

  
 

 

23) Once the 107 Chain is converted to a Point List Linear Feature in the Details Pane the 

Creation Type should be listed as GeneratedByPointList.   
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24) Next in the Details Pane highlight the row that contains the 107 Survey Chain and Right 

Click and select “Manage Point Feature List”. 

 

  
 

 

25) In the Point List Features Dialog Select/Highlight the row for Point 876.  After 

selecting the 876 row a round locator ball should now appear around the point in the plan 

view. 
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26) In the Point List Features dialog select the Join button and select the 107_1 chain.  

After joining the chains look in the Point Feature List dialog and the points from the 

107_1 chain (points 885-926) should have been added to 107 chain.  
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27) In the Data Acquisition Pane select Feature Styles.  

 

   
 

A list of all available Feature Styles (Codes) will be displayed in the Details Pane. 

 

Typically Point Codes are as follows: 

 

Survey Codes    1-999 

Photometric Codes 1000-6999 

Archeological Codes 7000-7999 
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28) In the Data Acquisition Pane, expand the Filters branch until you see Linear Features 

0059to13 

 
 

Notice in the Data Acquisition Details Pane that Linear Features 0059to13 is listed 

 

 
 

 

29) In the Data Acquisition Pane, under Filters Right Click on Linear Features 0059to13 

and select “Show Details”. 
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30) The Data Acquisition Details Pane will now list all the Linear Features (Survey Chains) 

that are included in the 0059to13 REC (Survey) file. 
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31) In the Data Acquisition Details Pane locate the Linear Feature (Survey Chain) 721.9 

and highlight the row.  Once the row is highlighted the Linear Feature should be centered 

in the screen 
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32) In the Data Acquisition Details Pane change the Feature of the 721.9 Linear Feature 

(Survey Chain)  to “720” 

 

 
 

 

From the Feature Styles explained in Step 27 a 720 feature is a “Flow Line”. 

 

 
 

Note: All columns in the Details Pane can be sorted by selecting Column Header. 
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33) Next we are going to attempt to reverse the direction of the Chain 721.9 so that the flow 

line goes in a southerly direction.  

 

Before the chain can be transposed the 721.9 Chain needs to be drop from a Dynamic Link 

Linear Feature to a Point List Linear Feature. 

 

To drop the 721.9 chain, Select/Highlight the row in the Details Pane and Right Click and 

select “Convert to Point List Linear Feature”  

 

 
 

 

34) Once the 721.9 Chain is converted to a Point List Linear Feature in the Details Pane the 

Creation Type should be listed as GeneratedByPointList.   
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35) Next in the Details Pane Select/Highlight the row that contains the 721.9 Survey Chain 

and Right Click and select “Manage Point Feature List”. 

 

  
 

 

36) In the Point List Features Dialog select/highlight all the rows.  After selecting all the rows 

left click on the Transpose icon and you should see the flow arrow switch to the south. 
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37) Next we are going to check for crossing breaklines.  First in the Data Acquisition Pane go 

to Field Books > J2P0223 > Linear Features and make sure Check Crossings for 

Surfaces is checked on. 

 

 
 

Then go to the Details Pane and select Message Center tab. 

 

If there is a crossing it will be listed here with the following warning icon.  

 

Select either of the two warning icons. 
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38) After selecting the first Crossing Breakline in the message box, Data Acquisition will 

center the window and place a locator ball at the point of crossing. . 

 

 
 

After looking at both crossings, it becomes clear that Point 489 is the cause of the crossings. 
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39) To remove the crossings you could do one of the following: 

 

Solution 1) Select the Point 489 using the Data Acquisition Select Element.  

 

Once selected in the Details Pane adjust the Northing, Easting coordinates until the crossing 

is resolved. 

 

 
 

 

Solution 2) Delete the Point using a MicroStation Delete.  

 

 

Solution 3) Remove Point 489 from the 721.20 Survey Chain. 

 

First you have to drop the 721.20 Chain down to a Point List Linear Feature. 

 

Select/Highlight the row containing the chain 721.20 and right click and select “Convert to 

Point List Linear Feature”. 
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Solution 3 continued: 

 

Select/Highlight the row containing the chain 721.20 and right click and select “Manage 

Point Feature List”. 

 

 
 

Select/Highlight the row containing the 489 point and then select the Delete icon.  

 

 
 

Once the Crossings are resolved the Message Center will no longer display the warnings. 

 

 
 

 

 

Note: When the 

Delete option is 

used the point 

is not deleted 

but just simply 

removed from 

the Survey 

Chain. 
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40) Next we are going to visualize the Surface and export the Surface out to a TIN file. 

 

In the Data Acquisition Pane select the Surfaces folder, and then expand the All Field Books 

and Features folders. 

 

Once you see all the items listed under the Features folder toggle on Triangles, Major and 

Minor Contours. 

 

 
 

In the Details Pane change (if needed) the following settings: 

 

Dissolve Option:  SideLength 

Side Length:  95 

Major Contour  10 

Minor Contour  1 
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41) To export out a Tin file select All Field Books > Export to… > GeoPak Tin. 

 

 
 

Select No Wizard 

 

 
 

Step 41 continued on next page: 
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41 Continued) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

. 

In ProjectWise select the 

following folder: 

 

pw:\\ 

  District CADD\ 

                   Survey\ 

                      BENTON\ 

                           J2P0223\ 

                                      data\ 

 

Click OK 

 

 

Below fill use the following 

name: 

 

            0059to13.tin 

Copy first line and then paste 
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42) Lastly we are going to export the geometry out to a GPK file. 

 

First check the settings in the User Preferences of the DGN file.  Right Click and hold on 

any blank area of the DGN window.  Then select User Preferences. 

 

 
 

Select COGO Preferences and then define the Job (GPK) Directory as follows: 

 

T:\Surv-proj\Benton\J2P0223\data\ 

 

 
 

Then select “OK” to close both dialog boxes. 
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43) Next select the Field Book J2P0223 and Right Click and select Export To > GeoPak 

Format. 

 
 

The Save As Dialog should be pointing to your COGO (job) directory.  Type in the 

following file name: 

JOBxxx.GPK 

Where xxx = a numeric value 

JOB013.GPK 
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44) Review exported COGO data using GeoPak Coordinate Geometry. 

 

Select GeoPak > Road > Geometry > Coordinate Geometry 

 

Use the Magnify Glass to the right of the Job field to browse for you newly created GPK. 

 

 

 

 
 

In Coordinate Geometry use COGO Navigator to view you Points and Survey Chains. 

 

     
 


